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USE AND DISTRIBUTION NOTICE

e Santa Clara County RACES authorization is granted to use and
duplicate this material as-is as long as this page and the
copyright notices on each page are included, acknowledging
Santa Clara County ARES/RACES as the holder of the
copyright.

e Permission is granted to adapt this presentation to your
needs as long as you acknowledge our copyright and include a
note similar to "adapted with permission from Santa Clara
County ARES/RACES”

¢ For additional information on training or any of our programs
send an email to: info@scc-ares-races.org

2020 Year End
Summary, Update,
Preview

Santa Clara County ARES®/RACES
Revised: 8-Dec-2020
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2020 Objectives and Goals

e Aggressive Training and Exercise Plan
e Earn C4 Credential by Year End

Year in Review e Adding WiFi connection to BBS Backbone
for cities and agencies.

e March 11 - we cancelled or postponed all
events thru mid April

e March 17 — SCCo Shelter In Place order

Tim Howard, KE6TIM
Revised 7-Dec-2020

5 6
What we did to address COVID Classes Not Conducive to Remote Teaching
Cancelled or Postponed Added .
B - ¢ Message Passing Class
Mar — Net Control IIB Class Apr — Repeater Sprint Contest . . . .
) o — Numerous one-on-one participant interaction sending and
Mar — Fundamentals Class June — Field Packet Mini Drill receiving messages between two participants
Mar — Pop-Up NC Practice Oct —Sim. Public Service Event — Student interaction with instructor and other participants
Mar — Medical Health Exer. that does not lend itself to remote instruction
Apr—NC Type Il Class Modified & Rescheduled
May — Message Passing Class May — Pop-Up Message Passing What can you do?
Jun — Event Planning Class June — Pop-Up Packet Practice Read the Message Handling Procedures document is a good
Aug — RDF Mini Drill July — Field Ops Type IIA Class place to start. Reviewing the examples shown will make you
Nov — Message Passing Class July — Field Ops Type IIB Class a better message passer.
Www.scc-ares-races.org/training/courses/Msg_Passing/Message_Handling_Procedures_v191115.pdf
Modified some classes for Presentation via Zoom

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved. 2
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Classes Not Conducive to Remote Teaching

¢ Event Planning Table-Top
— Close interaction between team members during the class.

— Participants are seated at a table and plan a simulated Pa C ket
event. They discuss requirements and plans for
equipment, staff, addressing each aspect of an event: NC,
Packet, Field Ops, Shadows, Logistics, Safety, Staging, etc. U pd ate

What can you do?

Review the class Event Planning handouts Jim Oberhofer, KN6PE

If you want to gain experience volunteer to help plan an Revised 7-Dec-2020

event at the city level, or assist an experienced planner on
one of the county events.

Weekly Packet “Practice”

2020... by the numbers (through 8-Dec-2020)

Total Practice Messages sent 1394 1744 3138 2844 2116

% Correct all the time  96.6% 94.7% 95.5% 93.7%  93.2%

Ave # of Participants / Night 27 34 31 29 25.5

Packet Exercise V\/

11 12
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Weekly Packet “Practice”

e See the “Standard Packet Check-In/Out Message” App Note
under...
https://www.scc-ares-races.org/data/packet/index.html#app-notes

e See the Practice Message, Subject section under...
https://www.scc-ares-races.org/data/packet/weekly-packet-
practice.html#Message

What was new, different in 20207

13 14

440 access channels added Mutual Aid Request Form
BBS Call Signs and Frequencies SCC RACES e Gy st s g
SR o B (R TITRe T
e ] T e n]
e The Mutual Aid Request form 5;-:; R :___.;
Call Sign| AX25 |User Access BBS-BBS | Location is used to request radio RACES  [w=r = ==
WIXSC | WIXSC1 [ 145.750, 223 620, 433570 Santa Clara Co Office Bldg (San Jose) operators during an activation.  [se= (7
W2XSC | W2XSC-1 || 145 730, 223 560, 433 590 Crystal Peak (South County) e This form is now part of the P T et
W3XSC | W3XSC-1/|144.310, 223540, 433.450 Palo Alto public packet installer 150M. S ' .
W4XSC | WAXSC-1 [ 145.690, 223 6007, 433550 | 223600 | Frazier Peak (above Milpitas) ¢ Do not use for...
W5XSC | W5XSC-1 | varies varies Training, events, backup — RACES Public Service Events . Loed ! ) [ :
W6XSC | WXSC-1 || varies varies | Testing, backup —  Non-RACES jurisdiction mutual =i B

aid requests

e Recommendation
— Individuals use 2m or 440 access ( more readily available equipment)
— EOCs use 220 access (less congested)
— Download and print this listing for your Go Kit

— Check web site and bulletins for changes

15 16
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Zoom!

Packet training in pajamas

e Ran all the packet classes by zoom

e Zoom registration helped track who actually showed up (and
stayed for the entire class!)

e Completing the homework was prerequisite for class credit

e Office Hours offered a chance for troubleshooting, a 1-on-1
chat, and general Q&A

e Quizzes... checked if you were still with us

 polis

1. If anything is possible, is it possible for anything to be
impossible?

Yes
No
Maybe

Wha?

Launch Polling

17

18

Quizzes help check how we are doing

User Name ~ | Question
2 =qz.
“as.
=as.
=a6.
=ar.
=as.
=az.
“as.
=as.
a6,
=ar.
~as.
=az
“as.
“as.
=as.
=ar.
=as.
“as.

Packet Radio is good for passing:
One city where a SCCo RACES BBS is located is:

T Answer

All of the above
Palo Alto

The TNG that is used by the County and many operators KPC3+

We use a tactical ealls in packet radio because:

it keeps the station packet address the sa

Areceived message displayed as red on the In Tray indi The message is Urgent.

What are PackitForms?
Packet Radio is good for passing:
One city where a SCCo RACES BBS is located is:

Forms-based messaging that supports sen

All of the above
Palo Alte

The TNC that is used by the County and many operators KPC3+

We use a tactical ealls in packet radio because:

What are PackitForms?
Packet Radio is good for passing:
One city where a SCCo RACES BBS is located is:

it kaeps the station packat address the sa
Areceived message displayed as red on the In Tray indi The message has not yet been read.
Forms-based messaging that supperts sen

All of the above
palo Alte

The TNC that is used by the County and many operators KPC3+

We use a tactical calls in packet radio because:

it keeps the station packet address the .

Areceived message displayed as red on the In Tray indi The message is Urgent.

What are PackitForms?
One city where a SCCo RACES BBS is located is:
o P d

palo Alto

a
Forms-based messaging that supports wrl

4

Outpost & PackltForms

Review

19

20
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SCCo Installer vi150M

What’s in the box? December 2020

PackltForm 3.2*

» PackltForms AutoPrinting

* Move the XSC RACES Mutual Aid Request from the private to
the public edition

® SCCo Integrated Packet Installer 150M
e Qutpost Packet Message Manager

— GUI-based interface for managing packet communications + browse.cmd enhancements and updates
— Makes using packet as simple as using e-mail + Various form updates
* PackitForms Outpost v3.4 c015*
— Next generation HTML-based forms for use with Outpost By the numbers These were related to
— Headless Chrome for auto-printing support e 1New Feature 12 - Message Handling
15 Defects 9 — PackltForms AutoPrinting
e PacFORMS

« 33 Enhancements 5 — Other Addon Enhancements
— HTML-based forms for use with Outpost e 19SCCo Submitted 4 — Opscripts

— Since 2007, simplified forms-based data entry, reduced network 49 Total changes -+ plus another 19 various changes

bandwidth
*See the release notes for details
21 22
4. Message changes
Popup Menus
* Pops up a specific menu of
common commands or controls. s
¢ Highlight a message and right- M
click to open the popup menu %‘
¢ Added to Era :
— Outpost message listing [_owwa | o
— When creating a new message .’ﬂ'f'.’_l .
— After receiving a message L T
’ H NOTE! Missing your favorite e
What’s new with =4
Outpost and PackltForms

23 24
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3. Message changes

Received/Sent message form

i

. r. ara e Oote | Oese oo «|A|
Enhancing Readability New mossage form ‘l(:
] b
e Ever notice the a|A|in the upper right {1 we] v oulaes “‘"
portion of the forms? ] = o X

e These controls decrease or increase the ]
font size of the text areas.

Outpost message nsul gy

¢ Changes are preserved and will be applied
the next time you run Outpost.

HINT: If you have a lot of Unread Messages

(those shown in BOLD), you must restart
Outpost for the font resize to take affect.

2. New installation?

 (PUBLIC EDITION -

* On a NEW clean install, Outpost now
defaults the data directory to

C:\SCCo Packet

Select a data location
Wihere should SCCo Packet it be instaled?

¢ If Outpost is not pointing to this
data directory now AND your
installation works fine, then
there is no need to change it.

o ] [

25 26
1. AutoPrinting for PackltForms 1. AutoPrinting for PackltForms
e AutoPrinting of PackltForms has been an objective since the Features
PackltForms initiative was kicked off. 1. Automatically print messages when they are received, or sent
¢ The main requirements were: 2. Includes plain text and PackltForm messages
— Message printing should occur automatically for both outgoing and 3. Selectable number of copies for received and sent messages
incoming messages. This will build on the capability that exists for 4. Add footers to PackltForms
plain text messages. _ o When should you use this
— The user can control turning AutoPrinting on and off. 1. Need to distribute messages to different teams in the EOC or ICP
— All auto-printing occurs without user intervention. 2. Keep track of who gets which copy
. ;he ?Du.tpost v3.4 V|VIth PackltForms 3.2 releases make Who is using this now
utoPrinting a reality.
J ¥ 1. SCC RACES at the County EOC
27 28

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved.
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Step by step process Plan for printing copies
AutoPrinting

1. Install the latest version of SCC Installer 150M 1. Before you do anything, make sure you know who needs to
2. Run Outpost get copies of SCCo PackltForms. For instance, suppose you
3. Set up Send/Receive Settings plan on distributing message copies to the following:
. . — Radio Room
4. Set up General Print Settings ~ Planning & Intel
5. Doit! — Operations
e Next...

29 30

Set up Outpost for AutoPrinting Set up Outpost for AutoPrinting
2. From Outpost 3. From the [View Copy Name] button
’ Automation | Recang Prnting | Noicatons | Otmer | (or Tools > G I Settings) Starup| Addvessing] Profles Prnting | wiscellaneous |
— Tools > Send/Receive Settings, Automatical prit during he SendReceive Session or Tools > General Settings) , SRS
L Print messages o the HP Offce et 4850 series prnter -
Printing Tab i E}?ter the Copy Na";:S ?’S yEIquant 1% Use Copy Nams ormanualprning
_ Check AutoPrint ¥ Pritrecehedmessages.. 3 copes (1109) them to appear on the PackltForm Copy s (s  eparte s for sch ops )
I~ Printsent messages. [T coples (1109 footer; one per line. fasoroon
v i i - Prnt DELIVERY and READ recept messages ) X . :
E:f:f;:"nlur;cb‘::‘: cr:)‘:is::-g:i:rn:jhis e e o — The order in which you enter them is operatons
example. ’ 15 ot cops ramas o ooees 0 [ ieW Gy s the order they will be printed. o on o Syt sy
R Tum on PDF Spooler (shod be on
v Check Print sent messages if you want v Ifyou wan.t t‘_) use Copy Names for )
outgoing messages printed. n;am;aldpnntmg, make sure that box is
¥ Check Print copy names... if you want checked.
footers printed.
If you intend to use Copy Names, press oK Apply Cancel | NOTE! The PDF Spooler should always oK Aoy Cancel
the [View Copy Name] button to set the be on.

Copy Names. NOTE! Copy Names refers to
the footer text that is placed on
the bottom of the PackltForm.

31 32
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Watching it happen

4. With this setup, you MESSAGEFORM mmpe mmy st
e - g =
just received a B e 9 e s st :3;"”.‘
PackltForm 1CS213 o | :Emwl " ™ "
e v [l —,
message. Within 30 P bt e
seconds, you see 3 ——
b

copies printed out.

-
R b
veaes W o tharsef
“He
~ Amatour Radio: * Othar:packet Oate: 1370572930 Tione: 24525
7 e
s - —_—
e peverryery Sk
cur-1562r Oparatiom. Puge el 1 I

Controlling what gets printed

copies to be printed.

in our example).
*  Which takes precedence?

1 Radio Room Radio Room
Planning & Intel
Operations

3 Radio Room Radio Room
Planning & Intel Planning & Intel
Operations Operations

4 Radio Room Radio Room
Planning & Intel Planning & Intel

Operations Operations
<blank footer>

¢ On the Tools > Send/Receive Settings, Printing Tab, you have number of

* On the Tools > General Settings, Printing Tab, you set the copy names (3

If # coj is set AND Copy Names | Then what is printed...
to...

33 34
What about manual printing? What’s new for 20217?
o Same rules apply. e e Maintenance release planned
¢ To print more than one copy, e — Adds suggested changes to PackltForms
- File > Print... pane — Fixes reported bugs; more enhancements to Outpost
— Select your Printer e Po packet Exercise
— Change Number of copies p-up X !
— Print! — Date... thd
e To try multi-copy printing e Packet class schedule
without actual paper-printing, — Packet Type IlIA  7-Aug-2021
select, try... ~ Packet Type llB 2-Oct-2021
— CutePDF Writer
—  Microsoft XPS Document — Packet Type Il 6-Nov-2021
— OneNote
— Snagit 12 print driver
NOTE: Not all print drivers support
multiple copy printing
35 36
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For More Information

e Support

— See the Santa Clara County ARES/RACES web site packet page
o https://www.scc-ares-races.org/data/packet/index.html

— Join the packet discussion group
* Practice
— Send a message during the weekly packet net, either or both days

® https://www.scc-ares-races.org/data/packet/weekly-packet-practice.html

¢ Automated feedback to help you improve, verify you've got it right
— Participate as a packet operator at drills and other events

Simulated
Public Service Event
and ARRL SET

Andreas Ott, K6OTT
Revised 3-Dec-2019

Photo credits: Leslie Grimm KK6EKN, Loretta Keller WB6BWQ, Mark Laubach K6FIC

37

38

2020: the “uneventful” year

e Zero public service events this year, even the one quarterly drill
outdoor activity needed to be called off due to heavy smoke
(extremely bad air quality in August)

¢ Almost no other qualifying events for credentials

¢ New Concept: the parade is simulated and everything was made
up. Follow scripted playbook activities for actors, to “provoke”
radio traffic that closely resembles the one from the real world
parade.

e Exercise built for two hours, run it twice: once you are an operator,
once you are a simulator

¢ Designed as deployment exercise with very little training
component (not strictly meant for newbies)

¢ Entirely outdoor, physically distant operators, no “touch”
community items (sharing radios)

¢ Adhere to state and county COVID-19 guidelines, stay home if you
have symptoms, wash your hands, don’t touch your face

Nobody saw that coming...

e We moved into uncharted territory by putting on an event that is
100% simulated. The Pros @SCC_OES hire a specialized and $$$
consulting firm to put on exercises like “Yellow Command”.

e Prior Art: “Drill in a binder” in Los Altos

* Your Planning Team: 8 core members, plus input from Jim Clark,
N6JRC and the real parade Nancy

e 4 weeks planning, 7 meetings, estimated 350 hrs

¢ Developed framework and placed events on the timeline, put tasks,
injects and instructions into playbooks. Procedure to automatically
generate printed sheets for each simulator from the MSEL (master
scenario events list) spreadsheet. Create roleplay instructions for
Principals. Write briefings for all positions. Go!

39

40

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved.
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MSEL based planning
Statistics - day of the event
e Parade documents + map

¢ Handling “situations”, Lost
Parent & Found Child

o Briefings

e Reduced number of SET categories scored, only one agency,
one community served, no formal traffic

e 44 Amateur Radio Operators participated, approximately 300

* 4 netcontrols on 3 nets, volunteer hours delivered
rotate every 25 mins

e Of these were 15 “new” hams, licensed since 2016

— * Parade Principals and e 100% of stations on emergency power!
— shadows Current ARRL SET 266, THANK YOU!
S ——— e Curren score 266, !
— e One MSEL per net . . )
e « One Iniect task heet f e |t's just slightly more than a quarter of the points compared
s privesia o ooy e ot e vy ne lniec . a: <Eer S> Ze or to last year, but better than nothing. We don’t know yet how
N simulators: at <time>do the big hitters will score.
- N et <this> until <that>
Unfortunatey, nobacdy can be o wht The Matixis. * Float drivers, pedestrians
41 42

Photos: Parade Route

After Action talking points

e We did OK on prescribing the Simulation, but it depends on
the actors pulling their weight acting them out through
roleplay

¢ Some simulation took on a life of its own

¢ Some simulation events need more QA, especially if they are
multi-step or multi-operator

e We exercised some real world scenarios (open mike, traffic
during netcontrol shift change)

e Forms handling has improved!

e During an activation: you MUST NOT leave home without
being checked in on the Resource Net

43 44
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Photos: Operators in position

Photos: Simulator Briefing

45 46

Photos: Parade Floats at Third Street Photos: Netcontrol

47 48
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Photos: Police Liaison near Safeway Photos: Hotwash debrief

49 50

Photos: award winning masks Jeff & Kelly

Intermod Calculator

Andreas Ott, K6OTT
Revised 3-Dec-2019

51 52
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Intermod Calculator Spreadsheet

¢ From 2020 Antenna Fundamentals Class
* We only had one event for which we needed to calculate any potential intermodulation
distortion, and that event also used more than 3 frequencies. So, this tool was of
limited use.
*  Still looking for feedback
* |s aspreadsheet the correct tool, or would you rather use a Python3 script (which could
be made to handle more than three frequencies)?
e Calculation for two transmit frequencies is performed for you, results are checked
against three receive frequencies
*  For two transmitters, the four most interesting 3™ order products are displayed and
cells use conditional formatting to display red background if too close to the third
frequency
= (), (26, (2f,+F), (2,4))
—  The first two are of most interest because they are near the two transmitters (or may land close to
other nearby receivers)
~  The last two are typically out of band (beware of VHF/UHF)
« Won't affect our other receivers
« Could affect other radio services at a shared transmitter site if not filtered, but not so important for an
isolated ham radio event
* Bonus: Spreadsheet also calculates 3" harmonics (2m and 70cm bands)

IntermodCalculator v2beta = & &
Fle ESt View Faert Formst Dala Tocis Addera Help
-Brs A wB B

e I R R L T e

s

v Gt 2 o

Roupt|2ino

Houtpa__[1inot

Qronsiries san 00258z

Vit 2030513 for artce rdarmantts a0 crosstan repasting cass
i e 00827 rvougn.J
4 B 3brequencier = Frequencies -

53

54

Training Plans for 2021

Judy Halchin, KKBEWQ
Revised 5-Dec-2019

Scheduled classes for 2021

¢ Introduction to Emergency Communications

¢ Fundamentals of Emergency Communications
¢ Field Operations lIIA, 111B/1I

¢ Net Control llIA, IIIB, II

e Shadowing

e Packet Operations llIA, 1IIB, Il

e Cross-Band Repeating / Antenna Fundamentals

(Zoom)
(Zoom)
(Outdoor)
(Zoom)
(Zoom)
(Zoom)
(Zoom)

55

56
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Zoom classes

¢ No need to travel

* Presentations work well

¢ Practice sessions work better for some people

¢ Many fewer questions asked during Zoom classes

e Very little interaction among the participants in Zoom

When it’s allowed and safe, we will go back to in-person classes,
but we’ll try to keep some of the benefits of Zoom classes.

Cupertino
Infectious Disease Response Plan

Jim Oberhofer, KN6PE
Revised 1-Dec-2019

Santa Clara County’s Slow Motion Emergency Situation
COVID-19 Cases Dashboard, 1 Dec 2020 What does this mean to us?
w0 * The COVID-19 pandemic is occurring, and will be with us for a while.
* The loss of life and associated economic and social trauma has been significant.
200 * Given the speed of its onset and expected duration, it is prudent to have a plan
in place that guides our emergency field response.
400
N * The complication of dealing with compound emergencies must be factored into
g any response plans to ensure we not only can meet the assigned mission, but
3 300 33 also maintain the health and safety of everyone involved.
289
o0 i ok . « Consider:
I e * earthquake ...
0 "m \U 136 ‘ « wildland fire threat... L ... during a pandemic
n oo 7 ‘ ‘ : ‘ ‘ Hl H M‘U ; ‘ g ‘ ‘ 200 year flood ...
02 e MNEERREIIN y || ||‘ | | | Il h Il || | ‘|| |\ || || I ‘ [ *The pandemic element of the response is what we addressed.
Mar 2020 M Jul 2020 Sep 2020 Nov 2020
@ New Cases @7-Day Rolling Average of New Cases

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved.
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Where to find it

Infectious Disease Response Plan

Welcome!
Home
About us
Operations
Frequencies Introduetion Infectious Disease Response Plan
Training 5 sctvaon Cupertino Citizen Corps

Exarcizas & Events  fikd dopioymant. Skis ara mantaingd by practios and dris. and ansuring|
Doca® Refersnces 1l 1ho response process s undarsiood, consistont and repeatabio. Ths

Resources L
Projects Sack

Supartine Citizen

Goron Standard Operating Procedures

i ame Gescrpton Contet

City of Cupertino

ER et
MarberLog S ksos

What’s in it

IDR Plan Contents

1 Introduction
11 Distribution

12
13 Object

14 Scope of impacted operat

15 Gitical

16 Minimizing the Risks a

17 Assessing
Proced

6
21 General Field Deployment Operat 6
22 Changesto ARK Level 3 Operati 7
7
8

23 Changesto ARK Level 2 Operati
24 Changes to ARK Level 1 Operati

25 Changesto Fire Station Operations 9
26 Comm 469 Operation: 10
27 Medical Reserve C i 10
3 Rolesand 1
3.1 Safety Officer, Assistant Safety Officer Checkist 1
32 Fixed Field Station Checklist 1
33 Indi Station Checklist 13
4 Policies 1
4.1 Vehicle Cleaning & 8 G 14
42 Hygiene Proced 15
43 Protocol for Possible Exposure 1
5 Logist rt 1
51 i ial required at CCC faclit 1
52 Responder Go-Kit 1
53 Half page CCC Health Attestation Form 1
A City Cleaning Supplies Document 1

B. CDC Guid

61

62

OES Goal... only one

Cupertino OES gave us only one goal for our Infectious Disease Response Plan, that is,
no matter what we do:

e Protect the health and safety of the public and Cupertino
Citizen Corps responders

Plan Objectives

1. Protect CCC responders and the community with whom we

interact
a. Protect their health and safety.
b. Maximize resources to maintain day-to-day emergency operations.
c.  Minimize the virus spread and reduce the impact on CCC and public health.

2. Maintain the continuity of response operations
a. Continue day-to-day readiness and response operations to the maximum extent
possible throughout all stages of the pandemic.

3. Execute the CCC pandemic response
a.  Ensure all CCC teams and facilities can fulfill their response responsibilities during a
pandemic.
b.  Communicate and coordinate pandemic preparedness and response to all City staff and
other CCC members.
c.  Support the efforts of the City in mitigating the consequences of a pandemic.
d. Do not become part of the problem.

63

64
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Leveraging from similar risks Distance
https://www.nrc.gov/about-nrc/radiation/protects-you/protection-principles.html M|n|m|z|ng paﬂdemic I’iSk
[ s
Limiting close face-to-face contact with others SOCIAL DlSTANCING
REPOR' i
s thebestway to reduce he preadof A
NUCLEAR NUCLEAR o NUCLEAR PUBLICNEETINGS& | c and other people outside of your home.
REACTORS WATERALS was SECURTY INVOLVEMENT
Prer & CDC recommends:
T Horme > About NRC > Radiaton Protecton > How NAC Prtects You > inimize Your Exposure «  Stayat least 6 feet (about 2 arms’ length)
i Minimize Your Exposure from other people. ——e

Regulaton of Radiaclive Haterials *  Limit close contact with others outside your

Although exposure to ionizing radiation carries a risk, it is impossible to completely avoid exposure.

[ .
Radiation has alwavs been bresent in the environment and in our bodies. We can. however. avoid household in indoor and outdoor spaces.
adaton onorng o uckerPower Time, Distance, and Shielding
Time, distance, and shielding measures minimize your exposure to radiation in much the same way as CCC Action Plan:
they would to protect you against overexposure to the sun (as ilustrated in the figure below): . - . . .
i . o h . ’ 1. Adopt and implement social distancing requirements to the fullest extent possible.

« Time: For people who are exposed to radiation in addition to natural background radiation,
limiting or minimizing the exposure time reduces the dose from the radiation source.

« Distance: Just as the heat from a fire is less intense the further away you are, so the intensity
and dose of radiation decreases dramatically as you increase your distance from the source.

« Shielding: Barriers of lead, concrete, or water provide protection from penetrating radiation such
a5 gamma rays and neutrons. This is why certain radioactive materials are stored under water or
in concrete or lead-lined rooms, and why dentists place a lead blanket on patients receiving
x-rays of their teeth. Similarly, special plastic shields stop beta particles, and air stops alpha
particles. Therefore, inserting the proper shield between you and a radiation source will greatly
reduce or eliminate the dose you receive.

65 66

Time (duration) Shielding / PPE

Minimizing pandemic risk Minimizing pandemic risk
(J
Most discussions on duration of exposure are aimed at Health Cloth face coverings are most likely to reduce
Care Professionals (HCP), especially those working in the the spread of COVID-19 when they are
vicinity of aerosol treatments. The time (or duration) aspect widely used by people in public settings.
of a contact comes into play when physical distancing .
requirements cannot be maintained. NOTE: You wearing a mask protects others
from you, not you from others.
Environmental considerations must be factored in when
thinking about limiting or minimizing any possible exposure time. CDC recommends:
*  Spaces with poor air circulation (rooms with little or no ventilation) may result in a build-up « People wear cloth face coverings in
of airborne viral matter that increases the likelihood of an infection. public settings when around people outside

of their household, especially when other
social distancing measures are difficult to
maintain

*  Conversely, spaces with good air circulation (spaces with open doors and windows, being
outside) reduce the viral load by dispersing it over it a wider area.
CCC Action Plan:

1. Do not engage in activities similar to those of HCP (be prepared to render First Aid if safe; do
so with proper PPE). 1. Cloth face covering is required when a CCC responder is near anyone else.

CCC Action Plan:

2. Maximize the use of outdoor spaces whenever possible to maintain good air circulation. NOTE: Starting June 18 2020, per state order, Californians must wear face coverings in
common and public indoor spaces and outdoors when distancing is not possible.

67 68
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Applying the Swiss Cheese Model

ANY SBFEGUBRD
WAS INHERENT
FLAWS OR HOLES

PROBLEMS OCCUR. WHEN MULTIRLE "HOLES " LINE. UP

T@sketchplanations.J. Reason)

i

N

3. Outdoor gatherings

Assessing Risks

Low risk High Risk

. Physical Distancing. Keep at least Close-up, in-person interaction
6 ft (2 meters) from others in

public.

. Crowded events

. Poorly ventilated spaces
. Reduced group size in enclosed

spaces

. People talking loudly, singing

[€ I N TR NN

. Prolonged exposure (15 minutes
of unprotected exposure with

. Sufficient ventilation someone less than 6 ft)

5. Face masks

Scope of the Plan 1. General Field Deployment Operations
1. General Field Assignments Highlights — CARES
2. ARK Level 3 Operations Deployment activities involve operating a radio in the field to report
. observations or passing messages by radio on behalf of someone else; applies
3. ARK Level 2 Operations to Infrastructure Safety Assessment, Ember Watches, and Alt911 operations.
4. ARK Level 1 Operations « A Safety Officer will be designated, either dedicated or in conjunction with other
: duties.
5. Fire Stations Operations « Exercise social distancing between responders and the public at all times, except as
. strictly necessary to carry out a task associated with the response mission
6. Comm 469 Operatlons * CCC members should recruit other household members as their Buddy
7. Roles and Responsibiﬁties * SS checks resource list for pre-identified members interested in single-person
solo) assignments
« Use two vehicles if two non-household responders travel to the same location
* If you are not comfortable with your surroundings or assignment, let your
supervisor know

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved.
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4. ARK Level 1 Operations

General Layout

6. Comm 469 Operations

. Layoutand people flow P — ' * Highlights —CARES

Incident Response Area

P « All General Field Deployment Operations changes apply.
\'SR?’@EM * Only one individual will occupy the Comm 469 cab at a time. Supporting
. \ staff follows in separate vehicles.
I ARKfTraier * When deployed, all vehicle operating compartment doors and roof vent
DSW Area will be open for increased air circulation.
Staging___| * Operations are split between inside and outside.

* Radio Room Operator (P3) and Shift Supervisor (P4)

‘—“m@ \ — * Resource Net (P1) and SCC County voice net/Packet (P2)

73 74

7. Roles & Responsibilities

Infectious Disease Response Checklists

tant Safety Officer Checklist

iave a designated Safety Officer named. This may be a dedicated or
shared position depending on the number of people at a specific location.

Chack

This checklistis) 3.2 Fixed Field Station Checklist
two or more res A fixed field station is a radio station set up at either a pre-defined facility or ad-hoc location where.

i put in place (¢ , tables, chairs, power, etc.). This

Bafore the EVent y,oiist covers Fixed Field Stations.
1K
2 Un Chesklis
T 7 et Thischecklistisreld 3.3 Individual/Mobile Station Checklist
3. Un responders are co-| An Individual/mobile station is where the operator uses an HT (Hand Talkie) or automobile-based
mobile radio to pass radio traffic. This checklist covers Individual Field Stations
During the Event Before the Event.
4 Me 1 Respo Checklist
U1 i the Epane TS EHECHIS i elevant or i G a tectious disease event more
5. Cle responders are co-located at a fixed field station to perform a specific event task
& Pr 2 Clean
T e 3. For as Befora the Event
s per respos 1. Responders confirm Go-Kit readiness including enhaneed PPE items.
4. sutio
9 En " During the Event
10. sig b. 2. Cloth face masks you k v of another person.
—_— “—:’C o 3, Maintain physical distance from any person that you encounter.
e
d
First Look Exercise, 14 Nov 2020 12, P;( . After the Event . )
i oft 4. On completion of your assignment, submit alinfectious disease-related paperwork to the
Cupertino ARES/RACES 13, pr —— > P“:"‘ City EOC {indlude these documents as part of Demob to be submitted to the Planning
> section).
5, Performs a full wipe down of your equipment, Replenish your stock any protection
stectha S, 2

Copyright €
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Go Kit Additions
¢ The following additional CCC Responder Go-Kit items are required:

1. Cloth face mask

2. Eye protection .

3. Nitrile gloves, at least 2 pair FO rm S ReVI eW

. I::o::?:rjgsdz:dditional CCC Responder Go-Kit items are Why the paperwork iS important

1. Hand sanitizer

2. Sanitizing wipes

3. Face shield Andreas Ott, K6OTT

Revised 7-Dec-2020
77 78
Broken record: From the lonesome event
Why logs are important this year
* The paperwork we get from you is part of us * Forms handling quality has improved compared to
exercising supervision over you while you last year!
are deployed. And we need proof of that in * Training works! So please attend our classes.
case we need to submit a DSW insurance * |CS-214 (FieldOps 3A and NetControl 3A Classes)
incident report form. and video training
By keeping good documentation we can * |CS-309 (NetControl 3A and FieldOps 3B Classes)
. ‘s . ” and video training
show that you did the “right thing ™”, also ) ,
important as a witness statement of events e This year’s event had no ICS-213 form messages
Imp (multiple classes / Monthly Practice Sessions)
e Butstill .....
80
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Problems 1: Did these operators
attend the same event | did?

ICS-214: only 9 lines are filled in (vs. 38
lines, or 21 lines on mine), no ICS-309

OK to be less verbose when it’s boring,
but just attending an event is 8 lines

Lost child/parent? crowd counts? H&W

Problems 2: Unit Name and Unit

Leader on ICS-214

* Unit Name: Your assigned tactical call

or the name of the net you are the
netcontrol for, might change

* Unit Leader: Your name and call sign
(fill in right away), won’t change

Time stamps out of order E::g;'igg ' Wockingors g Ky e ™ ;3’50?;2 e
ICS-214 last entry at 11:30, operator " Tacteal et Contol [ e onctr WexRL:.
left event at 14:30 according to ICS-211

81 82

Problems 3: Netcontrol ICS-309
This is the main log of all happenings
FROM and TO columns! See training
Message column: keywords

Use English, and we need to be able to
decode your abbreviations

* Shift Changes (wax on — wax off, don’t

forget to breathe)

* It should be obvious, but just in case

* And if you forgot your name, check
your Drivers License or FCC license

Problems 4: Radio Net Name and
Radio Operator Name ICS-309

2. Operational Period (Date/Time)

COMM Log | *neident Nome and Activan

ARES/RACES RIP-13-13T From: 2000 To: 0400

ion Number
1G5 309-3CCo Mockingbird Heights Mummy Race 10/31/13 11713

3. Radio NetName (for NCOs) or Position/Tactical Call
Resource Net

4 Radio Operator (Nome, Call Sign)
Wolf Man, WEWOOF

83
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Credential Program
Challenges During COVID

Tim Howard, KE6TIM
Revised 6-Dec-2020

Events are Required to Gain
Experience

* Experience in varied activities is an
important part of earning a Credential

* No Public Service Events
e Few Drills/Exercise

85

86

2020
Limited Number of Evaluations

* Pop-Up Packet — P3 and P2 Evals
* Quarterly Drill = N3, P3

* Quarterly Drill — F3 Evals cancelled due
to poor air quality (fires)

2021 Planned Eval Opportunities

* Pop-Up Packet —P3 and P2 Evals

* Quarterly Drills — N3, P3, F3, maybe
some Type 2 depending on evaluator
availability.

* We will remain open to other
opportunities that meet Credential
requirements without sacrificing
program quality.

87
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What about 2 year requirement Challenges

COVID is still with us and probably will
affect the number and types of
activities for some time.

* The Credential program requires that
requirements must be completed

within a 2-year period.
* We may plan events and later have to

* That time frame will be extended. cancel them if situations change.

¢ When that time frame is determined it

] ) * Bringing the resources (staff, location,
will be published.

scenario, etc.) together takes time and
* But, if an event/activity is offered try effort.

and take advantage, don’t wait. « Be patient and flexible.

89 90
DSW Stickers Update/Verify Contact Info
. My Contact Information
* New stickers for your County DSW card
[~Personal Contact
i i i H e woee | | Home phone: -555-
will be sent to the ECs for distribution. _— oisor WS | | et O
m‘ Last Name* [Munster Cell Phone#  [999-555-4321
° |f M Eiomens Address 1% 1373 Mockingbird Ln Pager
My Activity Record Address 2 e-mail #1* [WBXRLA@arrlnet
My Completion Centficates City* [Mockingbird Hgts e-mail #2  [hmunsteri815@gmai.com
* you are currently a County DSW by vt s o Sdrurtod,
i ivi ::::ﬁ?:iaﬂsmn _‘mxmmm
* your contact data in the activity database friesrrm— e o —— oy ot Samaciors
has been updated or verified within the Contack numbers  [099-555-1234 Phone 911 [GB05E5TTE
‘Thomas Bros. Map Information Fhonei2:
past 12 months. peisrolesediedoviyirers IR e —
Page (3 digits) * ’7 ‘e-mail #1 : |hmunster1815@gmail.com
Column (A-2)* | email#2: [
Row (1-9) * — SMS #1: [099-555-4321
* denotes required field rﬂ?&mﬁm‘:ﬂm:?nm
You last reviewed this information on: 01/07/2011
I have reviewed the information on this page |
Save Changes Clear changes and start again
91 92
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Thank Youl!

Please check your email and follow the instructions to
complete and return the Course Evaluation.

Q&A

All Staff

If you have questions or feedback about this or other training
activities, you can join our Training discussion group.
https://scc-ares-races.groups.io/g/training
This is a moderated group.

See you at a training class or exercise next year!

93 94
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